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La Guida all'installazione di FreeFlow Makeready fornisce le informazioni e illustra le procedure 
necessarie per eseguire l'installazione di un sistema FreeFlow Makeready. 

Per informazioni importanti sui requisiti di sistema e su limitazioni e problemi noti relativi 
alla versione software corrente, consultare le Note di rilascio di Xerox® FreeFlow Makeready. 
È possibile scaricare le note di rilascio dalla sezione Supporto e Driver in www.xerox.com. 

Introduzione 
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Questo capitolo contiene le procedure da eseguire per installare e configurare il software 
FreeFlow. 

Informazioni preliminari 
Il prodotto FreeFlow è supportato su piattaforme che soddisfano o superano i requisiti di 
sistema definiti da Xerox nelle Note di rilascio di FreeFlow Makeready. Per ulteriori informazioni, 
consultare la sezione Supporto e Driver su www.xerox.com. Il cliente installa e configura una 
versione opportunamente dotata di licenza del sistema operativo sul server, quindi installa 
il software. 

Prima di iniziare l'installazione del software FreeFlow, l'applicazione di installazione verifica 
i prerequisiti di sistema e mostra eventuali requisiti richiesti prima che l'installazione possa 
continuare. 

Nota: Per ottenere una licenza per il software FreeFlow, contattare il rappresentante o il 
rivenditore autorizzato e fornire il numero di serie del software e il numero dell'indirizzo 
hardware (MAC) del PC su cui verrà installato il software. La licenza (file .dat) stabilisce 
le opzioni che vengono abilitate durate l'installazione. 

Linee guida 
Assicurarsi di seguire le linee guida quando si utilizza l'applicazione di installazione di FreeFlow: 

• Per caricare il software richiesto, seguire le istruzioni su schermo. 
• Quando si installano applicazioni di terze parti, accettare sempre le impostazioni 

di installazione predefinite o tipiche. 

• Se viene visualizzata la finestra di dialogo Apri file - Avviso di sicurezza, eseguire il file 
indicato. 

  

Installazione e 
configurazione del 
software Makeready 

http://www.xerox.com/
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Prerequisiti delle specifiche di sistema 
Prima di installare il software FreeFlow, assicurarsi che sul computer sia installato il seguente 
software di terze parti: 

• Adobe Acrobat Pro 

Per installare il software Adobe Acrobat Pro con le impostazioni predefinite o tipiche, consultare 
le Note di rilascio di Xerox® FreeFlow Makeready per le versioni attualmente supportate. 

Per scaricare il software di installazione di Makeready, consultare la sezione Supporto e Driver 
su www.xerox.com [Assistenza clienti/Supporto e Driver/Software e piattaforme/FreeFlow]. 

Se è richiesta l'installazione di Copyright Management Service, configurare le impostazioni 
di IIS richieste. Per informazioni dettagliate, consultare la sezione appropriata in Appendice B: 
Ispezione. 

Nota: Se non si dispone di una copia della Guida per l'utente di FreeFlow Makeready Copyright 
Management Services, scaricare il documento dalla sezione Supporto e Driver su www.xerox.com. 

Installazione del software FreeFlow 
Per installare il software FreeFlow Makeready, procedere come segue: 

Nota: Prima di installare il software FreeFlow, assicurarsi che la piattaforma soddisfi o 
superi i requisiti di sistema minimi definiti nelle Note di rilascio di FreeFlow Makeready. 

1. Accedere come amministratore.  
2. Abilitare .NET Framework 3.5. 

a. Aprire il menu di avvio, digitare Pannello di controllo, quindi premere Invio. 
b. Selezionare Programmi > Attiva o disattiva funzionalità di Windows. 
c. Selezionare .NET Framework 3.5 include .NET 2.0 e 3.0, quindi selezionare OK. 
d. Se richiesto, selezionare Scarica file da Windows Update. 

Nota: È necessaria la connessione a Internet. 
e. Selezionare Chiudi. 

3. Assicurarsi di essere collegati al sistema come amministratore Windows e che non siano 
in esecuzione altre applicazioni. Se DPAdmin è l'account amministratore, continuare 
a utilizzare questo account. 

4. Per eseguire l'applicazione di installazione di FreeFlow Makeready, fare doppio clic 
su Makeready-9.0.xx.x-MN.exe, dove xx.x è la versione del file. Se appare la richiesta 
di confermare l'esecuzione del file, fare clic su Esegui. 

5. L'applicazione di installazione di FreeFlow Makeready viene avviata e vengono verificati 
i prerequisiti. Qualora vengano rilevate applicazioni richieste e non installate sul sistema, 
tali applicazioni vengono visualizzate in un elenco oppure viene visualizzato un messaggio 
di avvertenza. 

Nota: Se tutti i prerequisiti vengono soddisfatti, viene visualizzata la schermata di 
benvenuto. Se appare un messaggio di avvertenza, prima di continuare verificare 
che tutte le impostazioni siano configurate correttamente. 

6. Fare clic su Avanti. Viene visualizzata la schermata di benvenuto dell'applicazione 
di installazione di FreeFlow Makeready. 

http://www.xerox.com/
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7. Fare clic su Avanti. Viene visualizzata la schermata della licenza. 
Nota: Per ottenere una licenza per il software FreeFlow, contattare il rappresentante 
o il rivenditore autorizzato e fornire il numero di serie del software e il numero 
dell'indirizzo hardware (MAC) del PC su cui verrà installato il software. 

8. Per caricare il file .dat di licenza, completare i seguenti passaggi: 
 Fare clic su Aggiungi licenza. 
 Andare alla posizione del file .dat e fare clic su Apri. 

9. Se è richiesta l'installazione di Copyright Management Service (CMS), questo software 
richiede l'installazione di Internet Information Services (IIS). Prima di installare il software 
FreeFlow, installare e configurare IIS. Consultare Appendice B: Ispezione. 

 Se richiesto, selezionare le caselle di controllo per le applicazioni Copyright 
Management Service necessarie. Scegliere dal seguente elenco di opzioni: 
• CMS Server with Client license required (È richiesta una licenza di server 

CMS con Client) 
• Solo client CMS 
• Nessuna 

 Se si seleziona Solo client CMS, inserire l'indirizzo IP del server CMS. 
Nota: Se non si conosce l'indirizzo IP del server CMS, inserire 127.0.0.1. 

10. Fare clic su Avanti. 
11. Procedere in uno dei due modi seguenti: 

− Se appare la schermata Copyright Management Service, andare al passaggio 11. 
− Se appare la schermata Destinazione, andare al passaggio 13. 

12. Nella schermata Copyright Management Service, inserire i seguenti dati: 
ATTENZIONE: Assicurarsi di immettere la password dell'account nella schermata 
Copyright Management Service. L'applicazione di installazione utilizza questa informazione 
per configurare il database MSDE sottostante durante l'installazione. Una volta installato 
il sistema, non è possibile modificare questa informazione a meno che il software FreeFlow 
non venga reinstallato. 
− Password di amministratore database CMS. 

Nota: È necessario inserire una password complessa. Non utilizzare caratteri speciali. 
− Indirizzo IP o URL del server proxy con numero porta, se richiesto. 

Nota: Inserire l'indirizzo IP e il numero porta nel seguente formato: 
− IndirizzoIP:NumeroPorta o NomeServerProxy:NumeroPorta. 

Nota: Se non si conoscono le impostazioni del server proxy, lasciare i campi vuoti. 
Se necessario, è possibile cambiare successivamente i dati del server proxy dalla 
schermata di configurazione di CMS. 

− Nome utente account del server proxy, se richiesto. 
− Password utente del server proxy, se richiesta. 

13. Fare clic su Avanti. Viene visualizzata la schermata Destinazione. 
14. Fare clic su Avanti. Viene visualizzata la finestra Pronto per l'installazione. 
15. Esaminare l'elenco di opzioni da installare. Se un'opzione richiesta non è presente 

nell'elenco, fare clic su Indietro e apportare le modifiche richieste alla configurazione. 
16. Fare clic su Installa. 
17. Una volta completata l'installazione, viene visualizzato il messaggio Installazione 

di FreeFlow completata oppure un messaggio di avvertenza. 
18. Leggere il messaggio, quindi fare clic su Fine. Se appare un messaggio di avvertenza, 

risolvere il problema indicato. 
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19. Leggere il messaggio, quindi fare clic su OK. Il sistema si arresta automaticamente 
e poi viene riavviato. 

20. Quando il sistema è pronto, per completare il processo di installazione assicurarsi 
di accedere come l'attuale amministratore. Se DPAdmin è l'account amministratore, 
continuare a utilizzare questo account. 

 

Configurazione dell'account Copyright 
Management Service 
Completare questa sezione solo se è stato installato il componente opzionale Copyright 
Management Service (CMS). Se non si dispone di una copia della Guida per l'utente di FreeFlow 
Makeready Copyright Management Services, scaricare il documento dalla sezione Supporto 
e Driver su www.xerox.com. 

Nota: Il cliente è responsabile di registrarsi per creare un account con Copyright Clearance 
Center (CCC) prima di installare Copyright Management Service. È possibile accedere al sito 
Web di CCC su www.copyright.com. 

Per completare le seguenti procedure sono richieste le informazioni sull'account CCC. Se tali 
informazioni non sono disponibili, saltare questa procedura e continuare con i passaggi contenuti 
in Registrare stampanti di produzione. Copyright Management Service può essere configurato 
dopo che l'utente si è registrato per creare un account con CCC. Se le informazioni sull'account 
CCC non sono disponibili, il cliente può configurare CMS successivamente. 

1. Avviare Internet Explorer. 
2. Nella barra dell'indirizzo di Explorer, digitare: 

https://localhost:8090/CMS/CMSAdmin.aspx, quindi premere Invio. Viene 
visualizzata la pagina di amministrazione di CMS. 

3. Fare clic sul collegamento Configuration (Configurazione). 
4. Nel menu Section Names (Nomi sezioni), selezionare CMS Configuration 

(Configurazione di CMS). 
5. Nella colonna Key Value (Valore chiave), inserire le seguenti informazioni sull'account 

utente del database CMS del cliente: 
− Nome utente 
− Password 

6. Per verificare la connessione, fare clic su Test Configuration (Verifica connessione). 
7. Per salvare le informazioni, fare clic sul collegamento Update (Aggiorna). 
8. Chiudere tutte le schermate aperte. 
9. Per nuove installazioni, passare a Registrare stampanti di produzione. 

Registrare stampanti di produzione 
Per l'elenco delle stampanti di produzione Xerox e i controller supportati, consultare il 
documento Guida al supporto delle stampanti FreeFlow. È possibile scaricare tale documento 
dalla sezione Supporto e Driver in www.xerox.com. 
Per configurare le stampanti di produzione, completare i seguenti passaggi: 

Nota: I passaggi che seguono rappresentano una procedura generale progettata per facilitare 
l'installazione di una tipica stampante di produzione. 

http://www.copyright.com/
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1. Per avviare l'applicazione, selezionare Start>Tutte le app>Xerox>FreeFlow>Printer 
Registration. 

2. L'applicazione Printer Registration viene avviata e appare la finestra di dialogo Installed 
Products (Prodotti installati). 
Nota: Se viene visualizzato un Avviso di sicurezza Windows, fare clic su Sblocca per 
abilitare tutte le funzioni del programma. Se viene visualizzata la finestra di dialogo 
Controllo dell'account utente, fare clic su Continua. 

3. Dall'elenco dei prodotti installati, deselezionare tutte le caselle di controllo ad eccezione 
di Makeready. 
Nota: Per disattivare la visualizzazione della finestra Installed Products (Prodotti installati), 
è possibile selezionare Do not show this dialog again when launching application (Non 
mostrare più questo messaggio all'avvio dell'applicazione). Per configurare il software in 
modo che venga visualizzata la finestra Installed Products (Prodotti installati), da Printer 
Registration selezionare Options>Install Products (Opzioni>Installa prodotti). 

4. Per chiudere la finestra di dialogo, fare clic su OK. Viene visualizzata la schermata Printer 
Registration. 

5. Nella parte bassa della schermata, fare clic su Add (Aggiungi). Viene visualizzata 
la schermata della procedura guidata per l'aggiunta di stampanti. 

6. Nella casella di testo Printer Name (Nome stampante) o IP Address (Indirizzo IP), digitare 
l'indirizzo IP o il nome host del server di stampa così come conosciuto sulla rete. 

7. Procedere in uno dei due modi seguenti: 
− Per eliminare automaticamente il modello di stampante e il tipo di controller o di 

server, fare clic su Identify Configuration (Identifica configurazione). Una volta 
individuata la stampante, andare al passaggio 9. 

− Per inserire manualmente le informazioni sulla stampante, continuare con il passaggio 8. 
8. Dall'elenco a discesa dei modelli di stampante, selezionare la stampante appropriata. 
9. Assicurarsi che nel menu Controller/Server type (Controller/Tipo di server) sia selezionato 

il controller o server appropriato. 
10. Se si sta installando una stampante che supporta la funzione Alta protezione e si 

desidera configurare la funzione, assicurarsi che la casella di controllo High Security 
(Alta protezione) sia selezionata. 
Nota: Se la stampante non è configurata per la funzione di alta protezione e l'opzione 
High Security (Alta protezione) è selezionata, la stampa viene disabilitata. 

11. Fare clic su Next (Avanti) per procedere in uno dei seguenti modi: 
− Se la stampante supporta la registrazione automatica, viene visualizzata la schermata 

Automatic Printer Registration (Registrazione stampante automatica). Andare 
al passaggio 12. 

− Se la stampante non supporta la registrazione automatica, viene visualizzata una 
schermata con la richiesta di informazioni sulla coda. Andare al passaggio 13. 

12. Nella schermata Automatic Printer Registration (Registrazione stampante automatica), 
eseguire la selezione appropriata: 
− Per registrare automaticamente tutte le code di stampa, selezionare la casella 

di controllo per Automatically register all queues at printer (Registra 
automaticamente tutte le code sulla stampante), quindi fare clic su Next (Avanti). 
Andare al passaggio 13. 

− Per registrare solo specifiche code di stampa, lasciare vuota la casella di controllo 
Automatically register all queues at printer (Registra automaticamente tutte le code 
sulla stampante) e fare clic su Next (Avanti). Appare una schermata che richiede 
informazioni sulle code. Andare al passaggio 14. 
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13. Nella schermata di informazioni sulle code di stampa, effettuare le seguenti selezioni: 
 Selezionare la coda di stampa dal menu o inserire manualmente il nome della coda. 

Nota: Se High Security (Alta protezione) è selezionata e la stampante 
non è configurata per l'alta protezione, la stampa viene disabilitata. 

 Inserire un nome personalizzato descrittivo per la combinazione stampante/coda. 
 Fare clic su Next (Avanti) e andare al passaggio 14. 

14. Selezionare le combinazioni stampante/coda da registrare e fare clic su Next (Avanti). 
Viene visualizzata la schermata di impostazioni della stampante FreeFlow. 

15. Nella schermata di impostazioni delle stampanti FreeFlow, completare i seguenti passaggi 
per completare la configurazione della stampante: 

 Selezionare il percorso di stampa richiesto e le opzioni di gestione lavoro. 
 Se nella schermata è presente una casella di testo per nome utente e password FTP, 

inserire le informazioni appropriate. Alcune stampanti non utilizzano questo metodo 
e le caselle di accesso a FTP appaiono disattivate. 

 Fare clic su Finish (Fine). La stampante è registrata. 
16. Per configurare ulteriori stampanti, ripetere i passaggi 5-15. 
17. Per chiudere l'applicazione Printer Registration, selezionare File>Esci. 
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Questa sezione contiene ulteriori procedure di post-installazione per garantire la piena 
funzionalità del sistema FreeFlow. 

Questo capitolo comprende: 

• Aggiunta di funzioni dotate di licenza dopo l'installazione 

• Testare i percorsi di stampa 

• Installare uno scanner Xerox® DocuMate 

• Assicurarsi di aver eseguito una copia di backup del sistema 

Aggiunta di funzioni dotate di licenza dopo 
l'installazione 
Nota: Se è richiesta l'installazione di software opzionale, eseguire le procedure contenute 
in questa sezione. 

Gestione licenze consente di abilitare ulteriori funzioni dotate di licenza una volta completata 
l'installazione del software FreeFlow. Tutti i componenti con licenza vengono installati durante 
l'installazione di FreeFlow, ma per poter funzionare richiedono una licenza valida. Per ottenere 
le informazioni sulla licenza necessarie, contattare il proprio rappresentante o agente Xerox. 

È possibile installare il seguente software opzionale: 

• Set Labeling 
• Copyright Management Service. 

Procedura di post-
installazione 
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Nota: Copyright Management Service e Set Labeling vengono di norma abilitati durante 
l'installazione del software FreeFlow. Altre funzioni vengono visualizzate nello strumento licenze, 
tuttavia solo il software installato precedentemente è valido per la configurazione installata. 

1. Per eseguire l'applicazione FreeFlow License Tool, completare i seguenti passaggi: 
 Dal menu Start di Windows, selezionare Esegui. Viene visualizzata la finestra Esegui. 
 Nella casella di testo a discesa Apri, inserire FreeFlow installation 

drive>\freeflow\licensetool.exe, quindi fare clic su OK. Viene visualizzata 
la schermata Gestione licenze. 

2. Fare clic su Avanti. Viene visualizzato un messaggio di avvertenza. 
3. Per chiudere il messaggio, fare clic su OK. 
4. Completare i seguenti passaggi per caricare un file .dat di licenza: 

 Fare clic su Aggiungi licenza. 
 Andare alla posizione del file .dat aggiornato e aprirlo. 

Nota: Il caricamento di una licenza da un file .dat non rimuove le licenze di FreeFlow 
esistenti, semplicemente accoda o aggiorna le informazioni sulla licenza esistenti. 

5. Per seguire le istruzioni su schermo per completare il cambio di licenza, fare clic su OK. 

Quando il sistema è pronto, accedere e verificare che le funzioni richieste siano abilitate. 

Testare i percorsi di stampa 
Utilizzare questa sezione per testare i percorsi di stampa per tutte le stampanti installate. 

Testare le stampanti 

Per testare i percorsi di stampa disponibili, completare i seguenti passaggi: 

1. Dalla barra delle attività di Windows, selezionare Start>Tutte le app>Xerox 
FreeFlow>File Manager. 
L'applicazione File Manager si apre. 

http://www.xerox.com/
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2. In All Folders (Tutte le cartelle), fare doppio clic sull'icona e andare alla cartella di 
installazione di FreeFlow (unità di installazione:\Xerox\FreeFlow). 

3. Per testare il percorso di stampa di produzione, completare i seguenti passaggi: 
 Nell'area dei dettagli della cartella FreeFlow, individuare e selezionare il file 

PpTest.rdo. 
 Dalla barra dei menu, scegliere File>Stampa. Quando appare la finestra di dialogo 

Stampa, fare clic su OK. Viene visualizzata un'altra finestra di dialogo Stampa. 
 Assicurarsi che Stampa di produzione sia selezionata, quindi fare clic su OK. 

Viene visualizzata la finestra Impostazione lavoro. 
Nota: Se viene visualizzato un Avviso di sicurezza Windows, fare clic su Sblocca per 
consentire l'utilizzo di tutte le funzioni del programma. Se viene visualizzata la finestra 
di dialogo Controllo dell'account utente, fare clic su Continua. 
Nota: Se si sta inviando il file a una stampante utilizzando TCP/IP e l'account utente 
FTP designato in fase di registrazione della stampante non è stato creato sul server 
di stampa, viene visualizzato un messaggio che richiede all'utente di inserire un nome 
utente e una password per il server di stampa. 

 Assicurarsi che la stampante richiesta sia selezionata, quindi fare clic su Invia tutto. 
Viene visualizzata una finestra di stato che mostra la percentuale di completamento 
dell'operazione. 
Nota: Se viene visualizzato un Avviso di sicurezza Windows, fare clic su Sblocca per 
consentire l'utilizzo di tutte le funzioni del programma. Se viene visualizzata la finestra 
di dialogo Controllo dell'account utente, fare clic su Continua. 

 Verificare il documento stampato sulla stampante di produzione. 
4. Per testare il percorso di stampa PostScript, completare i seguenti passaggi: 

 Nella directory \FreeFlow, selezionare PsTest.rdo. 
 Dalla barra dei menu, scegliere File>Stampa. Quando appare la finestra di dialogo 

Stampa, fare clic su OK. Viene visualizzata un'altra finestra di dialogo Stampa. 
 Assicurarsi che Stampa di produzione sia selezionata, quindi fare clic su OK. 

Viene visualizzata la finestra Impostazione lavoro. 
 Assicurarsi che la stampante richiesta sia selezionata, quindi fare clic su Invia tutto. 

Viene visualizzata una finestra di stato che mostra la percentuale di completamento 
dell'operazione. 

 Verificare il documento stampato sulla stampante di produzione. 
5. Chiudere l'applicazione FreeFlow File Manager. 

Installare uno scanner Xerox® DocuMate 
In questa sezione vengono illustrate le procedure per l'installazione di uno scanner Xerox 
DocuMate, TWAIN 1.9 o versione successiva. Consultare le Note di rilascio di Xerox® FreeFlow 
Makeready per gli scanner attualmente supportati. È possibile scaricare tale documento dalla 
sezione Supporto e Driver in www.xerox.com. 
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1. Utilizzando un cavo USB, collegare lo scanner al sistema FreeFlow Makeready. 
2. Scaricare il driver DocuMate appropriato per lo scanner in uso. È possibile trovare i driver 

TWAIN e WIA certificati, insieme a ulteriori guide all'installazione e alla configurazione, 
su: http://www.xeroxscanners.com/en/us/support/DriversAndManuals.asp. 

3. Installare il driver dello scanner DocuMate. 
4. Assicurarsi che lo scanner DocuMate sia acceso e in esecuzione. Se lo scanner non è acceso 

e in esecuzione, i driver non verranno installati correttamente. 
5. Riavviare il sistema Makeready. 
6. Avviare l'applicazione Makeready. 
7. Selezionare File>Inserisci>Scansiona>Immagini. 

Si apre la finestra di dialogo Scanner DocuMate. 

Assicurarsi di aver eseguito una copia 
di backup del sistema 
ATTENZIONE: È responsabilità dell'utente eseguire un backup del sistema FreeFlow una volta 
completata l'installazione. 

Eseguire un backup completo del sistema locale da utilizzare per finalità di ripristino 
di emergenza. 

ATTENZIONE: Eseguire un backup completo di eventuali unità di memoria esterne, quali 
dispositivi RAID e così via. In caso di errore di sistema o danneggiamento dei dati, la mancata 
esecuzione di tali procedure può comportare la perdita irrecuperabile del sistema. 

 

http://w/
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Questa sezione comprende le seguenti informazioni: 

• Appendice A: Gestione del software FreeFlow dopo l'installazione 
• Appendice B: Ispezione 

Appendici 
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Installazione di patch e service pack 
È possibile aggiornare periodicamente il software FreeFlow utilizzando service pack e patch 
SPAR. Installare le patch in base alle necessità solo per risolvere uno specifico problema. I 
service pack sono approvati per tutte le installazioni. Installare i service pack per mantenere 
il sistema aggiornato. 

Nota: Le istruzioni che seguono sono di carattere generale. Le istruzioni su service pack e patch 
vengono fornite insieme a ciascun aggiornamento software. Seguire sempre le istruzioni 
fornite quando si installa il service pack o la patch. 

Per installare una patch di FreeFlow, completare i seguenti passaggi: 

1. Scaricare la versione più recente del software Makeready dalla sezione Supporto e Driver 
su Xerox.com. Il software FreeFlow Makeready è dotato di un programma di installazione 
completo che è possibile utilizzare per nuove installazioni o per l'installazione di patch. 

2. Fare doppio clic su Makeready-9.0.xx.xx.MN.exe, quindi seguire i passaggi su schermo. 
3. Una volta completata l'installazione, aprire l'applicazione FreeFlow e verificare 

che la revisione patch sia elencata nella schermata iniziale. 

Procedure di conferma e configurazione 
post-aggiornamento 

Verificare l'elenco di stampanti registrate 

Per verificare che l'elenco di stampanti di produzione registrate sia stato conservato, 
completare i seguenti passaggi: 

Appendice A: Gestione 
del software FreeFlow 
dopo l'installazione 
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1. Dalla barra delle attività di Windows, selezionare Start>Programmi>Xerox 
FreeFlow>Amministrazione stampante>Printer Registration. L'applicazione Printer 
Registration viene avviata e appare la finestra di dialogo Installed Products (Prodotti installati). 

2. Dall'elenco dei prodotti installati, deselezionare tutte le caselle di controllo ad eccezione 
di Makeready. 

3. Fare clic su OK per chiudere la finestra di dialogo. La schermata Printer Registration viene 
aggiornata e mostra lo stesso elenco di stampanti registrate. 

4. Verificare che l'elenco di stampanti registrate contenga tutte le stampanti presenti 
nel sistema precedente. 

5. Chiudere l'applicazione Printer Registration. 

Reinstallazione del software FreeFlow 
Se necessario, per reinstallare il software FreeFlow completare la seguente procedura: 

Nota: Questa procedura presume che tutto il software FreeFlow sia stato disinstallato 
utilizzando l'utilità Installazione applicazioni di Windows. 

1. Per eseguire il programma di installazione di FreeFlow Makeready, fare doppio clic su 
Makeready-9.0.xx.xx- MN.exe. Se appare la richiesta di eseguire il file, fare clic su Esegui. 

2. Fare clic su Avanti. Viene visualizzata la schermata della licenza. 
3. Se richiesto, modificare la licenza o aggiungere una licenza da un file .dat. 

Nota: Non è necessario aggiungere o modificare la licenza per una reinstallazione base. 
Il programma di installazione rileva la licenza esistente. 

ATTENZIONE: Nel passaggio successivo sono contenute istruzioni sulla navigazione tra 
le schermate del programma di installazione. A meno che non venga richiesto di modificare 
la password, se il campo della password contiene degli asterischi per gli account esistenti, 
non immettere una password. 

4. Navigare tra le schermate restanti e accettare i valori predefiniti. Immettere una password 
di sistema solo se il campo della password è vuoto. Se sono presenti degli asterischi, significa 
che il programma di installazione ha rilevato una password esistente per l'account. 

5. Una volta completata la procedura di reinstallazione e riavviato il sistema, assicurarsi 
che il sistema funzioni correttamente. 
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Disinstallazione del software FreeFlow 
Per disinstallare completamente il software FreeFlow quando è richiesta una disinstallazione 
completa, completare le seguenti procedure: 

Nota: Questa procedura non rimuove le informazioni sulla licenza e le informazioni su altri 
programmi Xerox archiviati nella cartella C:\Progam Files\Xerox. 

Ci sono due applicazioni Common Printer: Common Printer Status Tool e FreeFlow Printer 
Registration. Tali applicazioni vengono installate come parte del pacchetto di applicazioni 
FreeFlow, ma devono essere rimosse separatamente. 

1. Dalla barra delle attività di Windows, selezionare Start>Pannello di controllo. 
2. Selezionare Programmi e funzionalità. Viene visualizzata la finestra Disinstalla 

o modifica programma. 
3. Individuare l'applicazione Common Printer Status Tool e fare clic su Disinstalla. 

L'applicazione viene disinstallata. 

Nota: Se viene visualizzata la finestra di dialogo Controllo dell'account utente, fare 
clic su Continua. 

4. Individuare l'applicazione FreeFlow Printer Registration e fare clic su Disinstalla. 
L'applicazione viene disinstallata. 

Nota: Se viene visualizzata la finestra di dialogo Controllo dell'account utente, fare clic 
su Continua. 

Nota: La disinstallazione di Printer Registration non rimuove l'elenco di stampanti registrate. 
L'elenco viene mantenuto in c:\Windows\System32. 

5. Dall'elenco di programmi, selezionare FreeFlow Makeready. 
6. Fare clic su Disinstalla. Viene visualizzata una schermata di disinstallazione. 

Nota: Se viene visualizzata la finestra di dialogo Controllo dell'account utente, fare clic 
su Continua. Fare clic su Avanti per procedere in uno dei seguenti modi: 

− Se appare la finestra Installazione applicazioni, andare al passaggio 11. 
− Se appare una schermata di rimozione database, andare al passaggio 8. 

ATTENZIONE: Il passaggio successivo esegue la disinstallazione di Copyright Management 
Database. Prima di procedere, assicurarsi che sia necessario eseguire la disinstallazione. 
In alcune situazioni, è preferibile mantenere intatte le applicazioni di database. 

7. Per disinstallare Copyright Management Database, selezionare la casella di controllo. 
8. Fare clic su Avanti. Viene visualizzato un messaggio di avvertenza. 
9. Per confermare la rimozione del database, fare clic su Sì. Viene visualizzata una finestra 

di installazione applicazioni. 
10. Fare clic su Sì. Il software viene disinstallato. Viene visualizzata la schermata Rimozione 

completata. 
11. Fare clic su Fine Il sistema si arresta e poi si riavvia. 
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Le impostazioni di sistema richieste per Makeready sono elencate di seguito. Assicurarsi che le 
impostazioni di FreeFlow siano configurate in modo appropriato prima di iniziare la procedura 
di installazione del software FreeFlow. 

Impostazioni di sistema 
Di seguito sono illustrate le impostazioni di sistema richieste per il software FreeFlow: 

Nota: Per abilitare e configurare le impostazioni di sicurezza raccomandate, consultare il 
Documento sulla sicurezza di Xerox FreeFlow. È possibile scaricare tale documento dal sito 
Web della sicurezza Xerox su Information Security - Xerox. 

Disabilitare hyperthreading nel BIOS del PC 

Se questa opzione esiste, disabilitare hyperthreading nel BIOS del PC. Se necessario, consultare 
il proprio reparto IT per ulteriori informazioni. 

Verificare la memoria (RAM) 
1. Assicurarsi di essere collegato al sistema operativo come utente amministrativo. 
2. Fare clic con il tasto destro del mouse su Start, quindi selezionare Sistema. 
3. Verificare che la quantità di memoria installata (RAM) soddisfi o superi le specifiche 

minime elencate nelle Note di rilascio di FreeFlow Makeready e uscire dalla schermata 
Sistema. 

Disabilitare il Controllo dell'account utente 
1. Nel pannello di controllo, fare clic su Account utente due volte, quindi selezionare 

Modifica le impostazioni di Controllo dell'account utente. 
2. Per confermare le nuove impostazioni, spostare la barra su Non notificare mai, quindi 

selezionare OK. Se appare il messaggio “Consentire al programma seguente di apportare 
modifiche al computer?”, selezionare Sì, quindi nel riquadro a sinistra selezionare Pagina 
iniziale Pannello di controllo. 
Nota: Alcuni client non consentono che il Controllo dell'account utente venga disabilitato 
o che il pulsante “Non notificare mai” sia selezionato. Verificare questa impostazione con 
il cliente. Se richiesto, una volta completata l'installazione di FreeFlow, abilitare di nuovo 
l'impostazione. 

 

Appendice B: Ispezione 

https://security.business.xerox.com/en-us/
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Verificare i componenti del sistema operativo necessari 

Se è richiesta l'installazione di Copyright Management Service, configurare le impostazioni 
di IIS richieste. 

Nota: Assicurarsi di disporre del disco di installazione di Microsoft Windows. 

Nota: Nella sezione che segue, non rimuovere o disabilitare nessuna delle applicazioni 
del cliente. Se necessario, aggiungere soltanto le seguenti applicazioni. 

1. Dal pannello di controllo, selezionare Programmi. Selezionare Programmi e funzionalità. 
Selezionare Attiva o disattiva funzionalità di Windows. 

2. Espandere la finestra Funzionalità Windows. 
3. Espandere Internet Information Services, quindi espandere Server FTP. Verificare 

che quanto segue sia attivo: 

− Servizio FTP 
4. Espandere Strumenti di gestione Web e verificare che quanto segue sia attivo: 

− Espandere Compatibilità di gestione con IIS 6 
• Console di gestione IIS 6 
• Strumenti di scripting di IIS 6 
• Compatibilità WMI con IIS 6 
• Compatibilità di configurazione con IIS 6 e la metabase IIS 

− Console di gestione IIS 
5. Espandere Servizi web e verificare che quanto segue sia attivo: 

− Espandere Sviluppo applicazioni 
• .NET Extensibility 3.5 
• ASP 
• ASP.NET 3.5 
• Estensioni ISAPI 
• Filtri ISAPI 
• Server-Side Include 

− Espandere Funzionalità HTTP comuni 
• Documento predefinito 
• Esplorazione directory 
• Errori HTTP 
• Contenuto statico 

− Espandere Integrità e diagnostica 
• Registrazione HTTP 
• Monitor richieste 

− Espandere Funzionalità prestazioni 
• Compressione contenuto statico 
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− Espandere Sicurezza 
• Autenticazione di base 
• Filtro richieste  
• Autenticazione Windows 

6. Verificare che Microsoft .NET Framework 3.5 sia attivo (stato indicato da un riquadro 
ombreggiato). 

7. Per assicurarsi che i componenti necessari siano installati, fare clic su OK. 
8. Selezionare Riavvia ora. 
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